














































2. Next choose a font for the header or footer. Click on the right-hand 
button of the bar and a list of available fonts will drop down. Click to 
choose. Then specify a size, which can be typed in on the blanks 
provided. Although there are three blanks (the range of sizes is from 1 to 
144 points), you can type in single and double digit numbers. 

3. The next option in the dialog box is Style, where icons are provided 
to set your text as normal, bold, italics, underlined, outline or in any 
combination (except normal) you may choose. 

4. In the Distance from the Top box, type in the amount of space from 
the top of the page to the base of the header you want. In the Distance 
from the Bottom box, type in the amount of space from the bottom of the 
page to the base of the footer you want. 

5. On the last line of the dialog box, type in the text you wish to be 
displayed as the header or footer. To indicate information such as the 
current date, page number, or document name, AtariWorks provides a set 
of formatting commands, which can be entered on this line. These are 
described below. 

To use special formattingsin the Headers/Footers 

You can use special characters to automatically print cenain information in 
your header and footer. The "#" symbol and a lener is the special character set 
used. The following lists different commands you can use. Either upper- or 
lower-case letters can be used. 

#P Page Number 
#0 Current date, as set in your computer 
#T Current time, as set in your computer 
#F The document name (the extension in the filename is 

omined) 

You can also specify where the information is to appear. Use # followed by 
L, R, C for information to appear flush left, flush right, or centered. The string 
following such control characters will be printed according to the control 
character: 
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#L The following string is printed flush left. 
#R The following string is printed flush right. 
#C The following string is printed centered. 

You can use these control characters as many times as you want in your 
headerlfooter strings. You can also combine these special characters with 
regular text. 

Example: You type #L#F AtariWorks Manual #CPage 5-#P #ROraft #0 in 
your footer box. If the document name is SECTlON5.STW and you print it on 
January 7th, the footer on the third page reads: 

SECTION5 AtariWorks Manual Page 5-3 Draft January 7, 1993 

PRINTING A DOCUMENT 

You can print documents from all the AtariWorks tools. Although you adjust 
the format for each tool differently, you print them all the same way using the 
File menu. 

Setting Up Your Page 

Before you print a document, choose the Page Setup ... command from the 
File menu (or press [Shift)-[Control)-P) to specify exactly how you want it to be 
printed. The Page Setup ... command leis you specify paper size, headers, 
footers, and margins. 

To change page specifications: 

1. Choose Page Setup ... from the File menu. The Page Setup dialog 
box appears. 

2. Make changes in the dialog box as you want. 

3. Click the OK button or press the [Return] key. AtariWarks stores your 
specifications with the document, so you only have to change them once. 
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To Use Custom Paper 

With AtariWorks, you can print on any size paper that fits into your printer. 
To use a paper size other than those offered, click the custom size option in the 
Page Setup ... dialog box. For example, click Custom Size if you are printing 
maiting labels. Then you can specify the exact dimensions of your paper in the 
Paper Width and Paper Height boxes. 

To Use the Printer Paper Size Supported by the Printer 

Sometimes you may like to print your document on the paper supported by 
the printer driver. In order to check what size of paper your printer driver 
supports, click on Set Size to Current Printer. The current printer paper width 
and height will appear in the paper width and height boxes. 

Sending Your Document to the Printer 

When you're satisfied with your page setup, you are ready to print your 
document. 

1. Choose Print •.• from the File menu or press [ControIJ-P. 1I necessary, 
a Select Printer dialog box appears. Choose the appropriate printer and 
click the OK button. The Print dialog box will appear. 

2. Make any desired changes to the print specifications. (Clear entries 
with the [Esc] key.) 

3. Click the OK button to accept your specifications. AtariWorks begins 
to print your document. 

To Cancel Printing In Progress 

You can cancel the print command at the end 01 any printer page. Press 
the [ControIJ-C keys. AtariWorks may continue to print briefly until the printer's 
memory is empty. After printing stops, AtariWorks returns you to the document 
window. 
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TO QUIT ATARIWORKS 

1. Choose Quit from the File menu. If you've made changes to your 
document since the last lime you saved it, AtariWorks asks whether or not 
you want to save the changes. 

2. For each document, click Save to save your changes or Abandon if 
you'd rather not. Click Cancel to go back. 
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~ WP -
THE WORD PROCESSOR 

You can write jusl about anything with AtariWorks Word Processor: letters, 
memos, reports, press releases, advertising copy, or even a novel. AtariWorks 
also lets you use different fonts and graphics to help convey your written 
message. Furthermore, Marginalia allows you to place notes in your file that can 
be called up by someone else using AtariWorks. Owners of Atari computers 
with DMA sound (STe, TT, and Falcon series) can call up audio notes 
generated using the Audio Annotation feature. 

This Chapter of the manual shows you what you need to know about 
writing with the Word Processor: 

• Writing and Editing shows what a word processor document looks like, 
how to enter and edit text, and how to change the tont, the type style, and the 
type size. 

• Formatting a Document explains ways to arrange your writing on the 
page, and how to draw lines and shapes within a document. 

• Marginalia and Audio Annotation explains how to include private notes 
in your document. These notes can be written or, in some cases, they can be 
audio. 

• illustrating a Document explains how to draw lines and shapes in your 
word processing document and how to handle these illustrations as separate 
graphic files (GEM Metaliles). 

If you want to use the Word Processor with other tools-·for example, to 
create form letters or mailing labels with Database information , or to add charts 
from the Spreadsheet, see Using the Tools Together (Chapter 6) . 
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WRITING AND EDITING 

When you write and edit with the Word Processor, you don't have to retype 
whole pages to make a change. You just insert, delete, or correct your text , and 
AtariWorks automatically adjusts the lines within paragraphs and repaginates. 
After you finish editing with the Word Processor, you have a finished product, 
ready to print. 

This section shows you how to: 

• Recognize the parts of a word processor document, and create a new 
document. 

• Enter text. 

• Undo an editing mistake. 

• Select text and pictures. 

• Delete text and pictures. 

• Cut. copy, and paste. 

• Find and replace text. 

• Change fonts, type styles and type sizes. 

To Create a New Word Processor Document or to Open an 
Existing File 

When you start AtariWorks or choose New/Open (or press [ControIJ-N or 
[Control[·O) from the File menu, the Open dialog box appears. 

1. Click on the Word Processor icon. 

2. Click on the New button. AtariWorks opens a new word processor 
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document. You can begin typing . 

··or·· 

1. Click on the Word Processor icon. 

2. Click on the Open button. The file selector box appears. 

3. Select an existing file name to open. 

4. Click on the OK button . AtariWorks will open the chosen Word 
Processor document. You can start writing and editing. 

Entering Text 

Text is made up of charac1ers·· letters, numbers, symbols , and spaces are 
all characters to the Word Processor. The Word Processor stores the text in 
your computer's memory until you close the document or name and save the 
file, in which case it is also stored on disk. 

The Word Processor takes care of fitting your words into lines as you type. 
When you reach the end of a line, any word that doesn't fit within the right 
indent marker automatically moves to the next line. This is called wordwrap. 
Wordwrap lets you type complete paragraphs without pressing the [Return] key. 
If you insert text in the middle of a paragraph, wordwrap automatically expands 
the lines; if you delete text in the middte of a paragraph, wordwrap closes up the 
empty space. 

The Word Processor {Return] key actually types an invisible character, 
called a Return character. This character signals the end of a paragraph for 
wordwrap. You should press the Return key only at the end of a paragraph. 
Wordwrap makes a neat paragraph of anything between return characters. 

If you want to control the ends of lines yourself--as in poetry or lists, for 
example--you can press the [Return) key at the end of each line. A single line 
with a return character at the end is just a short paragraph to the Word 
Processor. Wordwrap won" affect these lines. 
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You can also use the [Return] key to insert blank lines into your document: 

1. Position the pointer and click (or use the cursor keys) to place the 
cursor (the flashing vertical line) where you want to insert the blank line. 

2. Press the [Return) key once if you're at the beginning of a paragraph, 
or twice if you're somewhere in the middle. 

You can insert text anywhere in a document by moving the insertion point: 

1. Position the cursor where you want to insert the text. 

2. Begin typing. Your text pushes the insertion point and any following 
text to the right. 

As you continue to type text into your word processor document, you will 
notice that a horizontal line appears on the left side of your Word Processor 
Window. This is a page break indicator. For more information about page 
breaks, see Formatting an Entire Document later in this chapter. 

When the page break has scrolled up on the screen so that it is the first 
line in the window, the page number box on the left side of the Tool Bar shows 
the page number corresponding to the first line of text in the window. 

Undoing a Mistake 

In many cases, choosing the Undo command from File menu (or pressing 
the (Undo) key) cancels the last action you've taken. You can undo most Word 
Processor commands from the Edit, Format, and Style menus. If you save 
your text otten (we suggest every ten minutes or so), you may prevent major 
mistakes that you cannot undo. Saving a document stores a copy of it on your 
disk. For more information, see Saving Documents in Chapter 2. 

One other kind of mistake can be easily fixed using the keyboard 
combination of the (Control] key and the letter T. Sometimes you may find that 
you have switched around letters in a word . Instead of form, for example, you 
may have typed from. To fix this transposition of letters: 
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1. Place your insertion point after the transposed characters (after ro in 
the example above). 

2. Press [Controlj-T (T for transpose). The letters will switch places and 
they will look like or in the example above. 

This function is strictly a keyboard function and cannot be accessed by any of 
the menus. 

Selecting Text and Pictures 

When you want to do something with a picture or a block of text--remove it, 
for example--you must first select it. AtariWorks shows a selection by 
;mmmiDlm't--turning black letters or pictures on a white background into white 
on black .. 

You can select a character, a word, a line, a sentence, a paragraph, any 
size block of text, or a picture. In most cases, you must select text and pictures 
separately. However, if, while you are selecting a block of text, you also select a 
complete picture, then both the text and picture will be selected. 

To Select by Dragging 

Position the pointer on one edge of what you want to select, and press the 
left mouse button. Drag to select as much as you want, then release the button. 
If your mouse pointer goes beyond the window boundaries AtariWorks will 
automatically scrolilhe document in the direction and select the text. 

Selecting a Single Word 

To select a single word quickly, move the insertion point to anywhere 
inside the word and double-click. 

Selecting lines of Text 

Position the cursor anywhere in the line desired. Press [Shift] and double­
click the left mouse button. The line is selected. If you want to select more than 
one line, drag the mouse. AtariWorks selects full lines as you drag. 
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Selecting Paragraphs 

Position the cursor anywhere in the paragraph desired. Press (Control) and 
double-click the left mouse button. The paragraph is selected. If you want to 
select more than one paragraph, drag the mouse. AtariWorks selects full 
paragraphs as you drag. 

To Select a Picture 

A picture can be a line or figure you draw with the Word Processor, or a 
chart from the AtariWorks Spreadsheet, or a GEM Metafile you have imported 
into your document. When you select a picture , a highlighted rectangle encloses 
the picture. 

1. Position the text cursor over the picture you want to select (it should 
overlap the text cursor). 

2. Choose Select Picture from the Edit menu (or press [ControIJ-Z). 

To Select an Entire Document 

You can also select an entire document without dragging the mouse. You 
may want to do this to change the font or format all the way through. Choose 
Select Ali from the Edit menu (or pr~ss (Controll-A). AtariWorks selects all the 
text and pictures in the document. 

Deleting Text 

You can delete single characters with the [Delete1 or [Backspace) keys, or 
you can select any amount of text and delete it with the Cut or Clear commands 
from the Edit menu. You can undo any of these actions with the Undo 
command from the Edit menu. 

To defete backwards: 

1. Position the insertion point to the right of the character(s) you want to 
delete. 

Chapter 3: The Word Processor 3-6 



2. Press the (Backspace] key. AtariWorks removes the character from 
your document. 

To delete forward: 

1. Position the insertion point to the left of the character(s) you want to 
delete. 

2. Press the (Delete) key. AtariWorks removes the character from your 
document. 

To defete a blank line: 

You can delete a blank line to close up the space between two 
paragraphs. Position the insertion point at the left edge of the first line of 
the paragraph you want to move back. You can press the (Backspace] key 
twice to join the two paragraphs into one. Or you can use the [Delete) key 
with the insertion point where the blank line is. 

To delete a selection: 

1. Select whatever you want to delete. 

2. Press the (Backspace] or (Delete] key or choose Clear Irom the Edit 
menu. AtariWorks removes the selection from your document 
permanently. 

--or--
Choose Cut from the Edit menu or press (Cantrall -X. AtariWorks removes 
your selection from the document and puts it on the Clipboard. This leads 
us to discuss other powerful editing functions. 

Cutting, Copying and Pasting 

As mentioned, the Cut command moves a selection from its current 
location to the Clipboard. The Copy command (or [Control]-C) leaves the 
selection where it is, but puts a copy on the Clipboard. The Paste command (or 
[Control)-V) copies the contents of the Clipboard to a new location. 
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The Clipboard is a special place on your computer's hard disk that holds 
information to be copied or transferred between documents or to different 
places in the same document. Each time you cut or copy information, the new 
selection replaces any old one on the Clipboard. The folder C:\CLlPBRO\ holds 
the information contained in the clipboard. 

To cut a selection: 

1. Select the information you want to cut. 

2. Choose Cut from the Edit menu (or press [Cantrall-X). The selection 
remains on the Clipboard until you cut or copy another selection. 

To copy a selection: 

1. Select the information you want to copy. 

2. Choose Copy from the Edit menu (or press [ControIJ-C) . The copied 
selection remains on the Clipboard until you cut or copy another selection. 

Once you have cut or copied a selection to the Clipboard, you can paste it 
to as many different places as you want. 

Each time you cut or copy information, the new selection replaces the old 
one on the Clipboard. So if you want to paste a selection that you've cut or 
copied, you must do so before cutting or copying anything else. 

To paste a selection: 

1. Move the insertion point to where you want to paste the Clipboard 
text. 

2. Choose Paste lrom the Edit menu (or press IControIJ-V). 

You can repeat these steps as often as you wish. You can also cut and 
paste between documents as well as within a document. Text put on the 
Clipboard remains there as you close one document and open another. 
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Note: AtariWorks supports intelligent cut and paste. If you select a word by 
double clicking and choose Cut or Clear or use [Backspace] or (Delete]. 
AtariWorks will remove any extra blank space along with the deleted word. Also. 
while pasting text. it pads extra blank spaces around the text being pasted. if 
needed. 

Finding Text 

If you're looking for a particular word or phrase, or want to move quickly to 
specilic text within a document, the Word Processor can find it for you. With the 
Find command, AtariWorks finds all occurrences of the text you specify. This 
can include instances where the text is embedded in other text. For example, if 
you tell AtariWorks to find able, it will highlight those four characters if it Hnds 
the word valuable. If you want AtariWorks to ignore such occurrences, click the 
Match Whole Words Only option. Also, AtariWorks ignores capitalization in the 
text you specify to be found. If you want to find only those occurrences of text 
where the capitalization is exactly as you type it in the text box, click the Check 
Case option. 

If you have graphic illustrations in your document, it is very time­
consuming when AtariWorks scrolls the document to show you what it has 
found. To make your search faster, select the Hide GEM Metafile option. 

To find text: 

1. Choose Find from the Search menu (or press (Control]-F). 
AtariWorks brings up a dialog box that asks you what you want to find. 

2. Type the characters you want to find. 

3. Select any of the options you want. 

4. Click the Find Next bunon. AtariWorks highlights the first occurrence 
of the string of characters if it is in the document. 

5. If you want AtariWorks to look for another occurrence of the text you 
specified, click the Find Next button again. 
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To cancel a search in progress: 

1. Press [ControIJ-C. AtariWorks stops the search wherever it is at that 
point. 

If, while you are typing or reviewing your document, you come across a 
word that is misspelled, you can select the word, and then choose Find. The 
selected word will appear in the Find box, so you don't need to type it. You can 
then find any other occurrences of the misspelled word. (Also see Spelling 
CheckerlThesaurus later in this chapter. ) 

Replacing Text 

You can replace text in a single location by selecting it and then typing 
over it. You can also have the Word Processor find a word or phrase for you in 
a document. Then, you can choose to replace every occurrence of it at once, or 
decide each case individually. 

For more extensive search and replace actions, use the Replace 
command from the search menu. The Replace command finds and replaces 
text. You can replace all occurrences of the text, or you can go through and 
selectively replace each occurrence. one at a time. As with the Find command, 
you can click options to specify whether AtariWorks searches for whole words 
only. for text with matching uppercasa and lowercase letters, or to hide GEM 
Metafiles, which speeds searching through documents that contain graphics. 
You can also select the text you want to replace before choosing the Replace 
command. then have it automatically appear in the Find What box. 

Sometimes a word or phrase occurs often. but you want to replace it in 
only one place. Use the Find Next button to find successive occurrences of the 
specified text until you see the one you want to replace. Or use the same button 
to verify each occurrence of the specified text before you replace it. After each 
replacement, you can look for another occurrence. 

There are several other buttons in the Replace dialog box. These tell 
AtariWorks to automatically replace all occurrences of the specified text, replace 
one occurrence and find the next. or replace only the occurrence you've just 
found. These buttons are: 
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Replace All: Click this button to replace all occurrences of the specified 
text in the document. 

Replace & Find: Click this button to replace the selected text and then find the 
next occurrence of the specified text. AtariWorks selects the next occurrence 
and waits for your further instructions. 

Replace: Click this button to replace the current selection only. 

To replace text: 

1. Choose Replace from the $earch menu (or press [Controll -A). A 
dialog box appears asking you what you want to find and what you want to 
replace it with. 

2. Type the text you want to find. 

3. Move to the second box by using the down cursor key, the mouse, or 
the (TabJ key_ 

4. In the second box type the new, replacement text. 

5. Select any of the options you want. 

6. Click one of the Replace buttons to start search and replace, or click 
on Cancel to exit. 

To cancel a search and rep/ace in progress: 

1. Press [Cantrall-C. AtariWorks stops the search and replace wherever 
it is at that point. 

Changing the Appearance of the Text 

You can change the font, type style and type size to add emphasis to or 
increase the impact of parts of your text. The font name (such as Dutch, Swiss, 
etc.) is the design of the characters. Each font can have different type styles 
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(such as boldface or italics) and type sizes (such as lO-point). You can change 
these characteristics as you're typing, or you can make a selection and then 
change them for the entire selection. 

To change the font or size of a selection: 

1. Select the text you want to change. 

2. Choose Fonts ... from the Style menu (or press [Controll -H). The 
Font Face Selector box appears. It lists the fonts that you have installed 
on your computer system from your own GDOS or SpeedoGDOS font 
sets. 

3. Choose the font name from the list. If it's the correct point size, you 
can double-click to make your selection. You can also use the scroll 
window to the right of the font list and click on the font size desired, or 
type in the font size in the box below. You can choose a size between 1 to 
144 points (2 inches tall). 

You can just change the font face or the point size of the selected block of 
text. If you just want to change the font face, erase the contents of the size box 
by hitting the [Escape] key or backspacing and select the font face you want 
and click on OK. The selected block of text will change to the font face you just 
selected without affecting the sizes y~u have used in the selected block. 

You can change typestyles in one of three ways: 

(1) To change the type style of a selection: 

1. Select the text that you want to change. 

2. Drop down the Style menu. 

3. Choose the style you want for your selection. 

(2) To change the font style while typing: 

From the Style menu, you can see that there are keyboard 
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equivalents to each of the styles available. Using these control key 
combinations while typing allows you to quickly change styles while never 
letting your fingers leave the keyboard. These keyboard equivalents are: 

(ControIJ-L: Normal, no style 
(ControIJ-B: Boldface 
(Control)-I : Italic 
(Control)-U: Underfine 
(Control)-E: Outline 

(3) To use the tool bar to change typestyles: 

On the right side of the Tool Bar is a set 01 icons for changing type styles. 
By clicking on the symbols N, B, I, U, 0 , Su, and Sb, you can then type 
text in the style represented by the symbol (or a combination of symbols) 
until you press the N icon for normal text or re-press a highlighted icon to 
deactivate the style. 

Everything you type will have the characteristics you choose until you 
change them again. If you move the insertion point to text with different font 
characterist ics. whatever you type will appear with those characteristics. 

There are no keyboard equivalents to Superscript and Subscript styles, in 
which case you can use the menu options to choose the style, then continue 
typing. However. there is yet another way to change text styles quickly-·by using 
a macro. 

The Macro Function 

The Tool Bar also contains an icon that accesses the Macro function.The 
Macro function combines the elements of font. style. and size. You can choose 
from among twenty such combinations to affect the appearance of your text. 
Macros can be saved and loaded so that style combinations used for a 
newsletter can be recalled from a previous word-processing session and 
different style combinations can be recalled for writing memos or letters during 
the same word-processing session. 

The Macro function is set up by use of the Define FonVSize/Style Macro 
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dialog box under the Style menu. The first bar of the box holds the names of the 
macros created. At the right end of the bar is the button for choosing one of the 
twenty macros available. These letter/number combinations correspond to the 
computer's function keys [Ft} through [Ft 0] ; the same function keys used with 
the [Shift] key held down correspond to functions [Ft 1] through (F20]. When you 
press the button, the list of 20 macros is displayed in a popup menu. 

For example, if you are creating macro styles for a newsletter, you may 
want to name macros for Title , Byline, Subhead t, Subhead 2, and Block Quote. 
These are the kinds of names you would type onto this first line of the Define 
FonVSize/Slyle Macro dialog box. 

! NeMsletter TutL _______ I F1 

Font : ~~~~~~D~ut~'~h~~~~~I~.~I I ~Mo~n~e l SizI! : I 12 '''''' . ~ .... . .-- , '0 'U ..... n ... 

Sty1. : I_ ~ IIlIlilIQl !l:J ~I Mone 

Below the Title/Key Definition bar are areas for choosing fonls , sizes, and 
styles. The Font box works the same as the first bar by providing a popup menu 
listing the available fonts. The Size box allows you to type in the size of the font, 
from 1 point to 144 points. You can type in Single digit and double digit numbers 
using the first two blanks, ignoring the third blank. 

The Style region includes the same icons used in the Tool Bar for 
choosing type styles. Choosing None means that you may go back to any text 
formatted wilh the macro and make individual changes in style. 
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To create a macro: 

1. Choose Macro ..• from the Style menu. The Define Font/Size/Style 
Macro dialog box will appear. 

2. Click on one of the Function Key lines (F1 , F2, F3, etc. ) and type in 
the name of your macro. 

3. Click on the Font line and choose a font. 

4. Click on the Size line and type in the size of your text. 

5. Click on the icon(s) in the Style area to choose your text style . 

6. Click on OK to set the macro and exit the dialog box. Pressing the 
function key you chose will now place you in the format mode you 
specified. 

You may repeat steps 2 through 5 until you have created as many macros 
as you need (up to 20). You may go back and add more without losing those 
you have already created. You can also go back and modify ones thai already 
exist. 

Once you have created your macros, you will want to save them for future 
use. 

To save a set of macros: 

Under the File menu, you will find the option for Save 
Format/Style ... . Use this command to name and save your macros. They 
will be saved as individual files with the extension FMT. 

To load a set of macros: 

Under the File menu, you will find the option for Load 
Format/Style ... . Use this command to load a macro set you've created. 
You will be offered the Item Selector from which to choose your macros, 
which have the extension .FMT. 
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FORMATTING A DOCUMENT 

The format of a document is how it appears on your screen or on paper. 
With AtariWorks, you can have the Word Processor do much of the formatting 
as you type. For example, you can specify thaI the first line of each paragraph 
should be indented half an inch. The Word Processor will then take care of the 
indenting--all you do is type and press the Return key at the end of each 
paragraph. 

This section shows you how to 

• Change spacing. 

• Change the alignment of text. 

• Use the ruler to adjust indentation. 

• Set tabs and make columns and tables. 

• Copy a format. 

• Format and print a document with headers and footers. 

You can have as many different formats as you want within a single 
document, but each format you choose will affect one entire paragraph. For 
example, if you double·space most of a report, but want to single space and 
indent quotations, make the quotations separate paragraphs. Once you've 
created a format style, you can copy it whenever you want to use the identical 
format. 

Using the Ruler, Tool Bar, and Formatting Commands 

The Word Processor provides two excellent visual tools for handling 
formatting of documents. Running directly along the top of your text area is the 
Ruler. With it, you can create format styles for your text. The Ru ler provides you 
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Example: 

If you have an investment represented by the cash flows ($5000), $t 000, 
$1500. $2000. ($3000). $2500. and $5000. which are entered in A 1 :A7. 
then: 

IRR (A1:A7. 10%) equals 15.05%. 

NPer( Rate. Pmt . PV • FV • Type) 

The NPer function gives the number of periods of an investment involving 
constant cash flow. A more complete description is provided below under Rate. 
If you omit FVor Type. their values are assumed to be O. 

NPV( Rate , values·1, values·2, ... ) 

The NPV function gives the net present value of a series of future cash 
flows, represented by the numbers in the list of values, discounted at a constant 
interest rate specified by Rate. 

The cash flows are assumed to occur at equal intervals, the first cash flow 
occurring at the end of the first interval. 

The list of values can contain one or more arguments. The values 
arguments should be numbers, or references that contain numbers. It a 
reference argument contains teX1 or blank values, those values are ignored. 

Pm1( Rate. Nper • PV . FV • Type ) 

The Pmt function gives the periodic payment of an investment involving 
constant cash flows. A more complete description is provided below under 
Rate. If you omit FVor Type, their values are assumed to be O. 

Use the following cash flow convention: represent cash received with a 
positive number, cash paid out with a negative number. 
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PV( Rate , ~Per , Pmt , FV , Type ) 

The PV function give the present value of an investment involving 
constant cash flows. A more complete description is provided below under 
Rate. If you omit FVor Type, their values are assumed to be O. 

Use the following cash flow convention: represent cash received with a 
positive number, cash paid out with a negative number. 

Rate( NPer , Pmt , PV , FV , Type. guess) 

The Rate function gives the interest rate per period on an investment 
involving cash flows. Rate is one of five standard parameters in cash flow 
problems involving constant payments. The other four functions already have 
been briefly described: FV (future vatue). NPer (number of periods) , Pmt 
(periodic payment), and PV (present value). The following discussion applies to 
all five functions when used together. 

Rate and Nper must refer to the same period or interval. For example, if 
Nper is the number of months, then Rate must reflect the effective monthly 
interest rate. 

Type indicates whether payments occur at the beginning or the end of the 
periods. If Type is 0, the first payment is assumed to occur at the end of the first 
period; if Type is I , the first payment occurs at the beginning of the period. If 
you omit Type from your function formula, it is assumed to be O. 

For the arguments PV, FV, and Pmt, use the following cash flow 
convention: cash received is represented by a positive number; cash paid out is 
represented by a negative number. The examples below illustrate this 
convention. 

AtariWorks uses an iterative technique to compute Rate, which can have 
zero, one, or two solutions. If the successive results of Rate do not converge 
after 20 iterations, Rate gives the error value "Error". 
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Guess specifies the starting value of the iteration. If you omit guess, it is 
assumed to be 0.1 or 10%. If Rate does not converge, try different values for 
guess. Usually, a starting value between 0 and I will yield a meaningful resu~. 

All of the arguments must be numbers. In PV, FV, NPer, and Pmt, you 
can omit the last two arguments, which will be assumed to be O. In Rate, you 
can omit the Jast three arguments, which will be assumed to be 0, except for 
guess, as noted above. 

AtariWorks uses the following equations to solve for one financial 
argument in terms of the others: 

PV' (1+Rate) • NPer + Pmt • (1 + Rate' Type) (/ + Rate) 
~NPer·1 +FV;O 
(for Rate <> 0) 

PV + Pmt ~ NPer+ FV= 0 
(for Rate = 0) 

Examples: 

(1) You have received a loan of $15,000 at an interest rate of 9% (monthly 
rate of 0.75%), and you must pay it off in 18 months, paid at the end of 
each month. PV is 15000, Rate is 0.75%, NPer is 18, and FV and Type 
are O. The monthly payment is calculated by the following formula: 

Pmt( 0.0075,18,15000) 

(2) A limited partnership plans to buy a commercial strip for $1 ,850,000 
with expectation of selling the property for $2,250,000 in 6 years. The rent 
for the commercial units amounts to $475,000 annually. PV is ·1850000, 
FV is 2250000, NPer is 6, Pmt is 475000, and Type is O. The numbers 
$475,000; $1 ,850,000;and $2,250,000 are entered in cells At, 82, and 
C3. If your guess at the annual rate of return is 10010, the actual annual 
rate of return is calculated using the following formula: 

Rate( 6 , A 1-82 , C3 , 0 , 0, 0.1 ). 
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(3) You presently have $3,200 in your savings account earning 6% annual 
interest (0.5% monthly interest, or 0.005 as Rate), and you plan to deposit 
$200 at the beginning of every month for the next 24 months. PV is 3200, 
Rate is 0.005, Pmt is -200, NPer is 24, and Type is 1. The amount of 
money your savings account will accumulate by the end of 24 months is 
calculated with the following formula : 

FV( 0.005, 24, 200, 3200 , 1). 

Logical Functions 

And( values- l • values-2 ... ) 

The And function gives the value 1 (TRUE) if all the values in the list of 
arguments are non-zero (TRUE). If any of the values is 0 (FALSE). it gives the 
value 0 (FALSE). 

If a reference argument contains text or blank values, those values are 
ignored. 

Examples: 

And(2+2:4,2+3=5) equals 1 
And(2+2=5,2+3=5) equals 0 

Choose( index . number-I, number-2 ... ) 

The Choose function uses index to select a value from the following 
arguments in the list. If index is 1. Choose gives number-1; if index is 2, 
Choose gives number-2; and so on. 

If index is less than 1 or greater than the number of the last value in the 
list, Choose gives the error value -Error- . 
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Examples: 

Choose( 2 , 10 , 20 , 30 , 40 ) equals 20 

If cells are used to indicate values, the above function would read like Ihis: 

Choose( A3 , 87 , C7 , 0 7 , E7 ) equals 87 

False( ) 

The False function takes no arguments and returns the value 0 (FALSE). 

Example: 

Choose( 2 , False( ) , True( ) , True( ) , False( ) , True( ) ) equals 1 

If( number , number-if true , number-if-false ) 

The If function gives number-it-true if number is non-zero (TRUE). and 
number-it-false if number is a (FALSE). 

Example: 

Given that A5 contains the number 98, and B1 0 contains the number 90: 
II( Or( A5<80 , 8 10<75 ) , 1 ,0 ) equals 0 

IsBlank( values-1 , values-2 ... ) 

The IsBlank function can have any number of arguments . All arguments 
must be cell references. IsBlank gives the value 1 (TRUE) if all cell references 
in the list of arguments are blank or contain text. Otherwise, it gives the value a 
(FALSE). 
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IsError{ value) 

The IsError function gives the value 1 (TRUE) jf value is the error value 
*Error· . Otherwise, it gives the value 0 (FALSE). 

If you want to see if a range of cells contains any · Error· values, use the 
Sum function to sum the range. If any cells contain *Error· , the result of the 
Sum function will be "Error· . 

Example: 

Given that Al contains the formula"" 3/0: 
If( IsError( A 1 ). 0 • 1 ) equals 0 

IsNA( value ) 

The IsNa function gives the value 1 (TRUE) if value is the error value N/A. 
Otherwise, it gives the value 0 (FALSE). 

Example: 

Given that Al contains the formula"" NA( ): 
If( IsNA( Al ). 0 . 1) equals 0 

Not( number ) 

The Not function gives the value 0 (FALSE) if number is non-zero 
(TRUE). and gives 1 (TRUE) if number is 0 (FALSE). 

Examples: 

Not( 1+ 1 "" 2 ) equals 0 
NOI( 1+ 1 .3 ) equals 1 
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Or{ values·' , values-2 ... ) 

The Or function gives the value 1 (TRUE) if any of the values in the list of 
arguments is non-zero (TRUE) . If all of the values are 0 (False), it gives the 
value 0 (FALSE). 

If a reference argument contains text or blank values, those values are 
Ignored. 

Examples: 

Or( 1+1 ,",2.2+2 _ 5) equals 1 
Orr 1+1 .3.2+2.5) equals 0 

True( ) 

The True function takes no arguments and gives the value 1 (TRUE). 

Example: 

Chooser 2 . False( ) • True( ) • False( ) • True( ) ) equals 1 

Mathematical Functions 

Abs( number) 

The Abs function gives the absolute value of number. 

Examples: 

Abs( 2 ) equals 2 
Abs( -2 ) equals 2 
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Exp( number ) 

The Exp function gives e raised to the power of number. The 
mathematical constant 8 is 2.7182818 ... , the base of the natural logarithm. 

This function is the inverse of the Ln function (natural logarithm). 
To calculate powers of other bases, use the exponentiation operator (") . 

Examples: 

Exp( 1 ) equals 2.7182818 (the value of the nalural base, e) 
Exp( Ln(3) ) equals 3 

Int ( number ) 

The Int function gives the largest integer less than or equal to number. 

Examples: 

Int( 8.9 ) equals 8 
Int( -8.9 ) equals -9 

Ln( number ) 

The Ln function calculates the natural logarithm of number. 

Natural logarithms use the mathematical constant e, 2.7182818 .. , as a 
base. 

Number must be positive. 

Ln is the inverse of the Exp function, e raised to the power number. 

Examples: 

Ln( 2.7182818 ) equals 1 
Ln( Exp( 3 )) equals 3 
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Ln( 8 ) 1 Ln( 2 ) equals 3 (the base 2 logarithm of 8) 

Log10( number ) 

The Log 10 function gives the base 10 logarithm of number. 

Number must be positive. 

Log10 is the inverse of base 10 exponentiation. 

Examples: 

Log10( 10) equals 1 
Log10( 1 E5 ) equals 5 
Log 1 O( 10' 5 ) equals 5 
Log10( 8) 1 Log10( 2 ) equals 3 (the base 2 logarithm of 8) 

Mod( number, divisor·number ) 

The Mod function give the remainder (modulus) after number is divided by 
divisor-number. The result has the same sign as divisor-number. 

Pi t ) 

If divisor-number is 0, Mod gives the error value *Error". 

Examples: 

Mod( 3 • 2 ) equals Mod( -3 • 2 ) equals 1 
Mod( 3 • -2 ) equals Mod( -3 • -2 ) equals -1 
Mod( 7 • 4) equals 7-lnt( 7 14 )"4 equals 3 

The Pi function takes no argument and gives the number 3.1459 ... , an 
approximation of the mathematical constant . 
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Example: 

ATan( 1 ) . 180 I Pill equals 45 (degrees) 

Rand( ) 

The Rand function gives a random number in the range a to 0.999 .... It 
generates a new random number every time the spreadsheet document is 
recalculated. 

Round( number , number-ol-digits ) 

The Round function gives number rounded to number-ot-digits. If number­
at-digits is positive, number is rounded to that many decimal places. If number­
at-digits is 0, number is rounded to the nearest integer. If number-ot-digits is 
negative, number is rounded to the left of the decimal point. 

Examples: 

Round( 2 . 15 , 1 ) equals 2.2 
Round( 2 . 149 , 1 ) equals 2.1 
Round( -1 . 475 , 2 ) equals -1 .48 
Round( 891 , -2 ) equals 900 

Slgn( number ) 

The Sign function gives 1 il number is positive, ° if number is 0, and -1 if 
number is negative. 

Examples: 

Sign( 7 + 3 ) equals 1 
Sign( 4 - 4 ) equals 0 
Sign( 3 - 7 ) equals -1 
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Sqrt( number) 

The Sqrt function gives the positive square root of number, 

Number must be greater than or equal to O. If number is negative, Sqrt 
gives the error value ·Error·. 

Special-Purpose Functions 

Error( ) 

The Error function takes no arguments and retu rns the value -Error·, 

Example: 

Given that Al contains the formula - Error(): 
If(lsErrar( A1 ).0 . 1) equals 0 

HLookup( lookup-number, compare-range I index-number ) 

The HLookup function searches the first row of compare-range for the 
largest value that is less than or equal to lookup-number. Having found that 
value in some column of the first row, HLookup moves up or down in that 
column by an amount specified by index-number and gives the value found 
there. (fndex-numbercan be any number; non-integers are rounded). 

If index-number is 1, HLookup gives the value from the current row. 
If index-numooris 2, Hlookup gives the value from the row below. 
If index-number is 0, Hlookup gives the value in the row above the 

current row. 
If index-number is -1 , Hlookup gives the value in the row that is two rows 

above the current row. 
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The values in the first row of compare-range must be in ascending order. 
If lookup-number is smaller than the smallest value in the first row of compare­
range, HLookup gives the error value ·Error· . 

Example: 

If At :E1 contains the values 10000, 20000, 30000, 40000, and 50000, 
and A5:E5 contains the values .01, .02, .03, .04, and .05, then: 

HLookup( 35000 , Al :E 1 , 5 ) equals .03 
HLookup( 35000 , Al :E , 1 ) equals 30000 
HLookup( 5000 , At :E1 , 5 ) equals *Error· 
HLookup( .035 , A5:E5 , -3 ) equals 30000 

Index( range, row , column ) 

The Index function gives the content of the indexed cell , selected by the 
indices row and column, start ing from the cell in the upper-left corner of range. 

Examples: 

Index( 82:04 , 2 , 3 ) equals the value of 03 
Index( 82:02 , 1 , 2 ) equals the value of C2 
Index( 82:84 , 2 , 1 ) equals the value of 83 
Index( 82:02 , 0 ,0) equals the value of A 1 
Index( C4:D4, -I , -1) equals lhe value of A2 

If A1 :A5 contains the numbers 10, 7, 9, 27, and 2, then: 

Index( A1:A5 , 3 , 1 ) 13 equals 3 

Lookup( lookup-number , compare-range, result-range ) 

The Lookup function searches compare-range for the largest value that is 
less than or equal to lookup-number. Lookup gives the corresponding value in 
result-range. 
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The values in compare-range must be in ascending order. If lookup­
number is smaller than the smallest value in compare-range, Lookup gives the 
error value ·Error·. Compare-range and result-range should have the same 
length. Each of these range arguments must be one-dimensional, but they need 
not both be in the same direction. 

Examples: 

If A 1 :E1 contains the oomparison values 10000, 20000, 30000,40000, and 
50000, and A4:E4 contains the values 10, 20, 30, 40,and 50, then: 

Lookup( 35000 , Al :El , A4:E4 ) equals 30 
Lookup( 5000 , A 1 :El , A4:E4) equals ·Error· 
Lookup( 35000 , Al:El , Al :El ) equals 30000 

Match( lookup-number , compare-range , type ) 

The Match function gives the number of the comparison value in 
compare-range that matches lookup-number. If lookup-number matches the first 
comparison value, Match gives 1. If lookup-number matches the second 
comparison value, Match gives 2, and so on. If lookup-number does not match 
any of the comparison values, Match gives the error value ·Error· . If compare­
range contains multiple rows, Match searches from leh to right. one row al a 
time; that is, it first searches the first row, then the second row, and so on. 

The rules for matching the values are determined by type: 

If type is 1, lookup-number matches the largest comparison value that is 
less than or equal to lookup-number. If lookup-number is less than the smallest 
comparison value, then it does not match any of them. The comparison values 
should be in ascendir.g order. 

If type is -1 , lookup-number matches the smallest comparison value that is 
greater than or equal to lookup-number. If lookup-number is greater than the 
largest comparison value, it does not match any of them. The comparison 
values should be in descending order. 
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If type is 0, lookup-number matches the first comparison value that is 
equal to looku,rnumber. If lookup-number is not equal to any of the comparison 
values, then it does not match any of them. The comparison values can be in 
any order. 

NA() 

Examples: 

If A 1 :A5 contains the numbers 60, 70, 80, 90, and 1 DO, then: 
Malch( 75 • A I:A:; • I ) equals 2 
Match( 55, A1:A5, 1 ) equals -Error-
If A 1 :AS contains the numbers 100, 90, 80, 70 ancl60, then: 
Malch( 75. AI :A5. ·1 ) equals 3 
Malch( 105 • AI :A5 • ·1 ) equals 'Error' 

If A 1 :C3 contains the numbers: 
10 20 30 
40 50 60 
70 80 90 then: 
Malch( 40 • AI :C3 • 0 ) equals 4 

The NA functions gives the error value NlA. 

Example: 

Given that A 1 contains the formula - NA ( ): 
If( NA( Al ). O . 1 ) equals 0 

Type( value ) 

The Type function gives the type of value. If value is a cell reference and 
the cell referenced is blank or contains text, Type gives 2. Otherwise, Type 
gives 1 when value is a number, 8 when value is the error value N/A, and 16 
when value is the error value ·Error·, 
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Examples: 

If A1 contains the text 'Smith', then : 
Type( A 1 ) equals 2 
Type( 5 ) equals 1 
Type( 1 10 ) equals 16 

VLookup( lookup-number, compare-range, index-number ) 

The VLookup function is identical to HLookup except that it searches the 
first column (rather than row) of compare-range, and moves left or right in that 
row by an amount specified by index-number. 

Statistical Functions 

Average( values-1 , values-2.:.) 

The Average function gives the average of the numbers in the list of 
arguments. The arguments should be numbers or references that contain 
numbers. If a reference argument contains text or blank values, those values 
are ignored. 

Examples: 

If A 1 :A5 contains the numbers 10, 7, 9, 27, and 2, then: 
Average( AI :A5 ) equals 11 
Average( A 1 :A5 , 5 } equals to 
Average( A 1 :A5 ) equals Sum( A1:A5 ) I Coun1( A 1 :A5 ) 

Count( values-l , values-2 ... ) 

The Count function gives the count of the numbers in the list of 
arguments. The arguments should be numbers or references that contain 
numbers. If a reference argument contains text or blank values, those values 
are ignored. 
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Examples: 

If A 1 :A5 contains the numbers 10, 7, 9, 27, and 2, then: 
Count( AI :A5 ) equals 5. Count( A 1 :A5 , 5 ) equals 6. 

The Max function gives the largest number in the list of arguments. The 
arguments should be numbers or references that contain numbers. If a 
reference argument contains text or blank values, those values are ignored. 

Examples: 

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then: 
Max( A 1 :AS ) equals 27 
Max( AI :A5 , 30 ) equals 30 

The Min function gives the smallest number in the list of arguments. The 
arguments should be numbers or references that contain numbers. If a 
reference argument contains text or blank values, those values are ignored. 

Examples: 

If A 1 :A5 contains the numbers 10, 7, 9, 27, and 2, then: 
Min( AI :A5 ) equals 2 
Min( AI :A5 , a ) equals a 

StDev( values-1 , values-2 ... ) 

The StDev function gives the sample standard deviation of the numbers in 
the list of arguments. The arguments should be numbers or references that 
contain numbers. If a reference argument contains text or blank values, those 
values are ignored. 
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The formula used is: Sqrt( Var( values-l , values-2, ... )) 

The sample standard deviation is the best estimate of the population 
standard deviation based in a sample of the population. If your sample 
represents the entire population, you can compute the true population standard 
deviation by including the average of the sample in the list of arguments to 
StDev: 

StDev( Population, Average( Population )) 

Examples: 

If A I :A5 contains the numbers 10, 7, 9, 27, and 2, then: 
StDev( At :A5 ) equats 9.460 
StDev( At :A5 , Average( At :A5 )) equals 8.462 

Sum( values-I , values-2 ... ) 

The Sum function gives the sum of the numbers in the list of arguments. 
The arguments should be numbers or references that contain numbers. If a 
reference argument contains text or blank values, those values are ignored. 

Examples: 

If AI :A5 contains the numbers 10, 7, 9, 27, and 2, then: 
Sum( At :A5 ) equals 55 
Sum( At :A5 , 5 ) equals 60 

Var( values-I , values-2 ... ) 

The Var function gives the sample variance of the numbers in the list of 
arguments. The arguments should be numbers or references that contain 
numbers. If a reference argument contains text or blank values, those values 
are ignored. 

The formula used is: (n"(x2) - (x)2) I (n " (n-t)) . 
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The sample variance is the best estimate of the population variance based 
on a sample of the population. If your sample represents the entire population, 
you can compute the true population variance by including the average of the 
sample in the list of arguments to Var, 

Var( Population, Average( Population )) 

Examples: 

If At :A5 contains the numbers 10, 7, 9, 27 and 2, then: 
Varl A 1 :A5 ) equals 89.5 
Var( A I :A5, Average( A I :A5 )) equals 71 .6 

Trigonometric Functions 

ACos( number ) 

The Acos function gives the arccosine of number. The arccosine is the 
angle in radians whose cosine is number. Number must be in the range ·1 to 1. 
The angle will be in the range 0 to 

Examples: 

Acosl -0.5 ) equals 2.094 12 13 radians) 
Acosl -0.5)' 180 I Pi() equals 120 (degrees) 

ASin( number ) 

Ther ASin function gives the arcsine of number. The arcsine is the angle 
in radians whose sine is number. Number must be in the range ·1 to 1. The 
angle will be in the range -( )/2 to ( )/2. 

Examples: 

ASin( -0.5 ) equals -0.524 I-I )/6 radians) 
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ASin( -0.5)' 180 I Pi() equals -30 (degrees) 

ATan( number ) 

The ATan function gives the arctangent of number. The arctangent is the 
angle in radians whose tangent is number. The angle will be in the range - ( )/2 
to ( )12. 

Examples: 

ATan( 1 ) equals 0.785 ( 14 radians) 
ATan( 1 ) . 180 I Pi() equals 45 (degrees) 

ATan2( x-number , y-number ) 

The ATan2 function gives the arctangent of x-number and y-number. The 
arctangent is the angle in radians determined by the point whose x and y 
coordinates are x-number and y-number. The angle will be in the range - to 
excluding . If both x-number and y-number are 0, Atan2 gives the value O. 

Examples: 

ATan2( t , t ) equals 0.785 ( 14 radians) 
ATan2( -1 , -t ) equals -2.356 (-3 14 radians) 
ATan2( -1 , -1 ) • t80 I Pi() equals - 135 (degrees) 

Cos( number ) 

The Cos function gives the cosine of number, where number is an angle 
in radians. 

Examples: 

Cos( 1.047) equals 0.5 
Cos( 60 • Pi( ) 1180) equals 0.5 
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Degrees( number ) 

The Degrees function converts an angle in radians to degrees. 

Example: 

Degrees( Pi( )) equals 1 80 

Radians( number) 

The Radians function converts an angle in degrees to radians. 

Example: 

Radians( 180 ) equals 3.14159 ... (lhe value of ). 

51n( number ) 

The Sin function gives the sine of number, where number is an angle in 
radians. 

Examples: 

Sin( a ) equals 0 
Sin( Pi( ) 1 2 ) equals 1 
Sin( 3· Pi ( ) 12 ) equals -1 

T8n( number ) 

The Tan function gives the tangent of number, where number is an angle 
in radians. 

Examples: 

Tan( 0.785 ) equals 0.990; Tan( 45 • Pi( ) 1 180 equals 1 
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